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Chapter 1: Getting Started 
What the CD Includes 
The installation CD includes the following 

1. An installation program for the infoQuest Core Clients. The installer includes un-
installation support. 

2. System Source Code (Visual Basic 6.0) 
3. The System Development Manual in the Microsoft Word 2000 and Adobe PDF 

formats. For printing, the PDF version is recommended. 
4. The User Manual in the Microsoft Word 2000 and Adobe PDF formats. For 

printing, the PDF version is recommended. 
5. Original structure charts and form layouts in Microsoft PowerPoint format. 
6. Windows 2000 Service Pack 3. 
7. Adobe Acrobat Reader 5.0 
8. Microsoft Word Viewer for Word 97/2000 
9. PowerPoint Viewer for PowerPoint 2000 
10. Installation files for the MySQL remote database system. 

System Requirements 
The following configuration is based on environments used during development. As 
such, they should be treated as mere recommendations as opposed to instructions. Where 
a specific brand of software is recommended, the recommendation should not be assumed 
to be the assumption of any liability, by the author that may arise from the use of the 
software. 

InfoQuest Core Clients 
The infoQuest core clients comprise DSN System configuration, Administrative Console, 
Student Records Management, Academic Registry Management, Advanced Search and 
the Mail Merge utility. The following is the recommended configuration 

1. An IBM compatible Personal Computer running Microsoft Windows 95, 98, 2000 
(SP3), ME, or XP 

2. A printer capable of printing onto A4 paper. 
3. CDROM Drive for facilitating installations. 
4. Microsoft Word 2000. Please not that if you do not have Microsoft Word, you 

will not be able to spell-check your Mail Merge documents. All other mail merge 
functions will however be available. 

5. Microsoft Excel 95. Please not that without Microsoft Excel, you will not be able 
to export advanced search results into the Excel format. You will however be able 
to export the other reports generated by infoQuest core clients. 
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Database Server 
The infoQuest clients are able to connect to any database system for which an ODBC or 
OLEDB driver exists. This includes popular remote database systems such as MySQL, 
Microsoft SQL Server and Oracle. The system is also compatible with desktop database 
systems such as Microsoft Access but their use is not recommended, as they are not 
suitable for multi-user environments.  
 
Given the freedom that infoQuest gives you in choosing your database system, you 
should carefully consider your alternatives before committing to any database system. In 
particular, you should consider the experience of your IT personnel, the financial 
resources you will be in a position to commit towards licensing fees and the system 
requirements of the database system. It is also important to consider the level of technical 
support that will be available for each database system under the licensing agreement that 
you will subscribe to. 

Installing The System 
In the following section, it is assumed that your CD-ROM is on drive D. If this is not the 
case then substitute you CD-ROM drive letter in the appropriate places. Please note that 
if you are installing on a Windows 2000 machine, you must first install Windows 2000 
Service Pack 3. The installation file for WSP3 is included on the CD-ROM under 
D:\W2KSP3. You should also ensure that the database system has been properly 
configured. 

 

 

Do not install the service pack unless you are absolutely sure that your 
machine does not already have WSP3 or any other later version of the 
Windows Service Pack. In addition, the Service Pack is meant for 
Windows 2000 only. Installing it on any other operating system will 
cause unpredictable results with the worst-case scenario being the total 
loss of ALL the data on your computer. 

Installing the infoQuest Core Clients 
a. Close any applications that you maybe running 
b. Insert the CD into your CD-ROM drive 
c. Copy the folder D:\Core Installation to your hard disk.  
d. Navigate to the folder that you will have copied the files to and run Setup.exe 
e. Follow the onscreen instructions. 

 

 
Please note that attempting to install the program from read only media 
such as CD-ROMs may cause the system to crash. 
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Configuring The DSN 
Before you can use the clients, you must configure a Data Source Name (DSN) that 
infoQuest will use to connect to your database system. To do this 
a. Install the database system’s ODBC or OLEDB driver on the machine on which you 

want to install the client(s). 
b. Refer to your Operating System’s documentation for information on setting up a Data 

Source Name. 
c. After setting up the DSN, start the infoQuest DSN Configuration Wizard. The wizard 

is automatically installed when you install any of the Core Clients. To start it, select it 
from the Windows Start Menu under Programs in the infoQuest tab. You will be 
presented with the following screen. 

 
 
d. Choose the Next button. You will then be presented with the following screen. 
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e. Choose the DSN button. This will open your operating system’s DSN selection 
window. For instructions on selecting the DSN, click the window’s Help button. If 
you select a DSN successfully, its details will be copied onto the white area just 
above the DSN button. You should not specify a username or password at this stage. 

f. Choose the Next button and you will be presented with the following window 

 
 
g. Enter the username and password that you will have been given by your Database 

Administrator. If infoQuest fails to connect to the data source, you will be prompted 
to resolve any of the problems that the system will be experiencing. If infoQuest 
successfully tests the connection, you will be presented with the following window 

 

 
 

h. Choose Finish to end the Wizard. 
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Where a database system provides you with a choice between an ODBC 
and an OLEDB connector, you are likely to experience better system 
performance if you use the OLEDB connector. 

 
 

Logging Into The System 
To ensure that only those who are authorised to use the system are the ones who gain 
access to it, infoQuest requires all users to log on and be authenticated by the database 
system. When you start any of the system components, you will be presented with the 
following screen 

 
To log on, 

1. Enter your username.  
2. Enter your password. 
3. Click on the Log In button. 

 

 

InfoQuest relies on your database system to authenticate users. As such, 
you should ensure that the database is configured to provide the level of 
security that you require. In particular, you should ensure that it does 
not allow anonymous logins. 

 
 

InfoQuest Core Clients 
Components Remarks 
Administrative 
Console 

• Used to configure the system.  
• Can only be used by the administrator. 
• Explained in Chapter 2. 

Academic Registry • Used to administer the academic registry. 
• Explained in Chapter 3 

Student Records 
Administration 

• Used to administer student records. 
• Explained in Chapter 4 

Advanced Search • Used to execute SQL  
• Explained in Chapter 5 

Mail Merge • Used for automatic mailings 
• Explained in Chapter 6 
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Getting Assistance While You Work 
All the windows that you are presented with within the system have online help support. 
You can get a quick summary of how to use the window by either 
¾ Clicking on the Help button. 
¾ Choosing Help from the menu if the window has one 
¾ Or pressing the F1 key. 

In addition, most buttons and input boxes will give you a quick summary of what they do 
if you place the mouse over them for a few seconds. 
 
Although the online system is handy, it is advisable that you skim through the entire user 
manual (Available on the CD) before trying anything out. You are also free to print out 
the manual. 
 
If you are stuck or discover a bug within the system, you may be able to get assistance by 
contacting the system developer at tgmotsi@yahoo.com. You may also want to have a 
look at the infoQuest website at www.geocities.com/tgmotsi which will contain updates 
for the system. 
 



 

Chapter 2: The Administrative Console 
 
The Administrative Console provides you with tools for setting up the database tables 
that infoQuest uses and configuring user accounts for online access. Please note that the 
user accounts configured here are not the same as the one you will have to setup for each 
user who will be using the Core Clients. The console is available from the infoQuest 
program group. 

Creating System Tables 
a. Select Initialise Table from the Admin menu 
 

 
b. The Table Initialisation will start and you will be presented with the following 

window. Please note that if your database already contains infoQuest tables, the 
initialisation will fail. 

 
c. If the table initialisation is successful, you will be presented with a message to that 

effect. 
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Managing Online Users 
Online user accounts are used for logging onto web based clients llike the Nominal Roll. 
In general, all system users should have an online user account. Those who use the Core 
Clients should in addition to the online account, have a database account preferable with 
a different password. 

Adding New Users 
The process of adding new users is carried out by infoQuest on your behalf when you 
start the Online User Administration service.  

 
InfoQuest scans the database for registered students, deregistered students, registered 
members of staff and deregistered members of staff who will not have online accounts 
and then adds them. In the process, it assigns a random password to each user which 
should be reset as outlined below before the user can begin using the system. 
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Configuring User Accounts 
a. Select the Settings button. You will be presented with the following window 
 

 
 

b. To reset the user’s password, enter the new password in the Password field and re-
enter it in the Confirm Password field. 

c. To allow the user to access the Nominal Roll web service, click the Nominal Roll 
box 

d. To allow the user to access student’s past assessment records, click the Assessment 
box. 

e. Choose Save 
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Chapter 3: The Academic Registry 
The Academic Registry comprises Departments, Members of staff, Classes and Subjects. 
Because you cannot register students until you have registered some classes, you should 
start by entering all of the Academic Registry information with the exception of the 
Subjects information which should be entered after you have registered some students. 

 
 

A Guide to infoQuest Icons 
In this and the next chapter, reference will be made to the following standard infoQuest 
icons.  

 
Icon Description 

 
Create a new record 

 
Edit the currently displayed record 

 
Delete the displayed record. For students 
and member of staff, the icon is for 
deregistration. 

 
Reregister a deregistered member of staff 
or student. 

 
Find a record 

 
Obtain a system wide report. 

 
Display online help for the task you are 
carrying out. 

 
Close the window. 
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Departments 
To access the Departments’ window, choose Departments from the Database menu 
shown above. You will be presented with the following Window 

 
 
1. To add a new department 

a. Choose the New icon  
b. You will be prompted to enter the name of the department. If the name is not 

unique, it will be rejected. 
c. If the addition is successful, the new department’s name will appear in the list of 

departments. 
2. To edit a department’s name 

a. Choose the Edit icon  
b. You will be prompted to enter the new name for the department. If the name is 

not unique, it will be rejected. 
c. If the edit is successful, the department’s new name will appear in the list of 

departments. 
3. To delete a department 

a. Select the Delete icon 
b. You will be prompted to confirm the deletion. Please note that if there are any 

members of staff who will be registered as being members of that departments of 
if there any subjects that will still be registered under the department, the deletion 
will be rejected. 

c. If the deletion is successful, the updated list of departments will not contain the 
department. 
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Members of Staff 
For employees at the school to have online user accounts, they must be registered as 
members of staff. You should therefore register all members of staff who may need to use 
the system even if they are not teachers. To access the Members of Staff window, choose 
Members of Staff from the Academic Registry’s Database menu. 

 
1. To browse through the records you can use the Previous, Next and the Search 

button. The search button allows you to jump to the record of any member of staff if 
you know his/her Staff ID. 

2. To register a new member of staff 
a. Choose the New icon 
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b. You will be presented with a form that will be blank with the exception of the 
Staff ID. Enter the title, initials and surname of the member of staff in the 
spaces provided.  

 
c. Select the member of staff from the list provided 

 
d. Choose the Save button 

3. To change a member of staff’s details 
a. Choose the Edit button 
b. Change the details you want to change. Please note that you will not be able to 

change the Staff ID. 
c. Choose Save 

4. To deregister a member of staff 
a. Choose the Deregister icon. 
b. You will be prompted to confirm the deregistration. Please note that the 

deregistration will fail if the member of staff is still being referenced in the 
system. You can check the references by request a system wide report as 
outlined below. 

c. If the deregistration is successful, you will get a message to that effect. 
5. Obtaining a system wide report 

a. Choose the Report icon 
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b. InfoQuest will scan the system for information about the member of staff and 
then provide the system to you in a comprehensive report that you will be able 
to save to your computer and/or print 

 
c. Icons for saving and printing respectively 

    
 

Heads of Departments 
To open the HODs window, choose Heads of Department from the Database menu. 
You will be presented with the following window 

 
This window enables you to specify the HODs for the departments you will have 
created using the Departments window. To specify a Head of Department 

a. Locate the record of the department by browsing through the records. 
b. Choose the Edit icon 
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c. Select the HOD from the list that will be provided 

 
d. Choose Save 

 

Deregistered Members of Staff 
The records of deregistered members of staff are provided for reference only. You can 
neither delete nor edit them.  

 
To add a new record, you must deregister an existing member of staff. In the event that 
you wish to reregister a member of staff whom you will have deregistered, proceed as 
follows 

a. Select the Reregister icon 
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b. You will be presented with a list of departments from which you should 
choose the department that the member of staff will join upon re-registration. 

 
c. Choose the Reregister button 

 

Classes 
1. To access the classes’ window, choose Classes from the Database menu. 

 
2. To add a new class 

a. Choose the New icon. You will obtain a form pre-filled with the Class ID 
b. Enter the class name which should be unique 
c. Enter the academic year 
d. Select the Form Teacher from the list provided 
e. Choose Save 
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3. To edit a record 
a. Choose the Edit icon. 
b. Change the details you want to change. Please note that you cannot change the 

Class ID. 
c. Choose Save 

4. To delete a class, choose the Delete icon. Please note that you cannot delete a class 
that is in use. 

5. To obtain a report detailing the students in the class, choose the Report icon. 
 

Subjects Offered 
The manage the list of subjects offered by the school, select Subjects Offered from the 
Database menu. You will be presented with the following window 

 
You can use the window to add new subjects and to edit the details of subjects offered. 
You however cannot delete a subject once you have created it. 

Subjects Taken 
There are three ways of managing the subjects taken namely Student View, Subject View 
and Batch Update. To access the services select Subjects Taken from the Database 
menu. You will be presented with a sub-menu from which you can then select the service 
you want. 
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Student View 
The student view shows you all the subjects for which a given student will be registered. 
You can add and remove subjects from this list. Please note that you cannot change the 
student details displayed. 

 
1. To add a subject to the list 

a. Select the Add Subject button. You will be presented with the window shown 
below. 

b. Specify how you would like to search from the subject from one of the 
following 

i. Subject code 
ii. Subject Title 

iii. All registered subjects 
c. If you are searching by subject code or title, enter the subject code or title. 
d. Select the Search button. 
e. The matching subjects will be listed in the Available box. You can move 

them to the Selected list by using the arrows. To find out what each arrow 
does, place your mouse over it for a few seconds. 

f. Note that you can repeat steps (b) to (e) to find other subjects which you can 
add to the list you will have. 

g. Whey you have finished selecting the subject you wish to add, choose the 
Add button. The subjects will be added with duplicates being rejected. 

2. To remove a subject, select it and then choose the Remove Subject button. 
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3. To remove all the subjects at once, choose the Remove All Subjects button. 

 
 

Subject View 
The subject view is similar to the student view and the same techniques used in the 
Student View may be used in the subject view. 
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The Batch Update Wizard 
1. Start the Batch Update wizard. You will be presented with the following windows 

 
2. Choose one of the options given and then choose Next. You will be presented with 

another window for specifying either the subject you want to replace or the one to 
which you want to add another subject. Select the subject and then choose Next 
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3. You will be presented with another window for specifying the subject to replace with 
or to add. Select the subject and then choose Next 

 
4. If the replacement/addition is successful, you will be presented with a window 

displaying a message to that effect. 
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Reports 
In addition to the reports that are available from the individual windows, you can also 
obtain other reports by choosing Reports from the Database menu of the Academic 
Registry. A sample reports showing a list of all the classes is show below. 
 

 
The reports can be printed or exported to a variety of formats by choosing the Print or 
Export buttons respectively. Formats supported for exporting include Excel, HTML and 
PDF among others. 
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Chapter 4: Student Records 
 
The Student Records client provides facilities for managing details relating to students 
such as Doctors, Parents, Medical Aid Details and Houses in addition to the records of 
the students themselves. 
 

 
 

Doctors’ Details 
To open the Doctors’ window, select Doctors from the Database menu show above. You 
will then be presented with the following window. 

 
1. To browse through the records, you can use the Previous, Next and Search 
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2. To register a new doctor 
a. Select the New icon 
b. The Doctor ID will be pre-filled for you. Enter the other details 
c. Choose the Save button 

3. To edit a doctor’s record, choose the Edit button. Please note that you cannot change 
the Doctor ID. 

4. Please note that you cannot delete Doctors’ records 
5. To obtain a list of the students who will be clients of the doctor, choose Report icon 

Medical Aid Details 
The Medical Aid window is accessible from the Database menu and looks similar to the 
window show below 

 
The window behaves in a similar way to that for doctors. It should however be noted that 
there is a restriction on the values you may enter. The combination of the name and type 
must be unique. For example, given the record shown above, one could register another 
medical aid type with a type of varsity as long as its name is not CIMAS. 

House Details 
The House Details window is accessible from the Database menu and looks similar to the 
window shown below. 
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This window also behaves in way that is similar to the Doctors’ window. However, when 
entering a new record or editing an existing one, you can only type in the House Name. 
For the Boarding Status and the House Master, you must select your entry from the 
lists that will be provided. The boarding status should be one of the following: Boarders, 
Day Scholars, Mixed or Weekly Boarders. The house master list will contain all the 
members of staff so the housemaster must be a registered member of staff. 

Parents 
To access the Parent’s window, choose Parents from the Database menu. Please note 
that when a member of staff is also a parent and/or a guardian, you will need to register 
him/her as a parent in addition to the registration as a member of staff. Also note that all 
the details in window will be required during editing and the making of new records. 
However, you can enter a ‘-‘ for all the details you will not be having. A sample Parent 
window is shown below. 
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Student Records 
This window provides you with a facility for recording student details. Please note 
however that it does not allow you to add or change the details of parents, doctors, 
medical aid types or houses. You must therefore register all these details before you 
attempt to register a student who requires them. A screen shot of the window is show 
below. 
 

 
 
When entering details on the form please note that 

a. You cannot change the Student ID and the date on which the record was last 
updated. 

b. The Family Tab gives you lists for entering the language, religion and 
parents’ marital status of the student. You are however still able to type in a 
value if it does not exist in the list. 

c. For the Doctor, Medical Aid, House, Class, Guardian, Mother and Father 
tabs, you must select the value to record by choosing the Select button shown 
below 
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d. The Relatives tab enables you to add and remove the students’ relatives at the 
school. The Add button will start a wizard that will help you locate the 
relative’s details from the infoQuest system. Once added, you can use the Edit 
button to edit the relationship and the Remove button to remove the 
relationship. 

 

 
 

e. To deregister a student, choose the Deregister icon. You will then be 
presented with the following window which you should fill. After filling in 
the required details, choose the Deregister button. 

 

 29



 

 

Deregistered Students 
The deregistered students facility archives the details of deregistered students. A screen 
shot of the window is shown below. 
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With the exception of the details recorded under the Contact tab, you cannot edit 
deregistered students’ details. You can however reregister a student by selecting the 
Reregister icon and then filling out the form show below which is similar to the 
Registered Students form 
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Batch Updating Classes 
At the end of the year, you may need to move all of the students in a given class to a new 
class. InfoQuest provides a facility for automating such a process. The facility can be 
accessed by choosing Batch Update Classes from the Database menu.  

 
 

You may find the following strategy useful 
a. Move all the Upper sixes and Form Fours into specials classes e.g. U6 Sc 

Leavers for all those who were in U6 Sc 
b. Start with the Lower sixes and end with the Form ones. 
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Chapter 5: Finding Information 
 
The Advanced Search Utility, shown in the diagram below, allows you to execute queries 
on the database for as long as those queries do not seek to modify data. This utility will 
allow you to find any information you may want from the database provided you know 
the SQL required for the query. In addition to knowing the SQL, you will also need to 
know the database structure. For information on the database table structure, consult your 
database administrator. 
 

 
 
The main search window, pictured above, allows you to manage your SQL files by 
saving and opening them later. The following is a summary of what the functions 
provided under the Tools menu of the main window do. 
 
Menu Item Remarks 
New Query Erases the query window allowing you to start working on a new 

query. 
Open SQL File Opens a previously saved SQL file.  
Save SQL File  Saves the currently displayed SQL file under its current filename if 

it already has one. 
Save SQL File As Saves the displayed SQL file under a different filename. 
Execute Query Presents the search results for the displayed query. 
Print SQL Prints the displayed SQL file text. 
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Viewing Query Results 
After entering your SQL or opening a predefined query, you can view the results it 
returns by choosing Execute SQL from the Tools menu. If the query finds any matches 
you will be presented with the following results window 

 
 
From the above show results window, you can do the following by choosing the 
appropriate function from the Tools menu. 
¾ Adjust column widths so that they display the full details. 
¾ Export the results to Microsoft® Excel 
¾ Export the results to a generic format understood by all spread sheets  
¾ Adjust the row height. For example you can instruct the system to display 4 lines 

of text for each record so that you can view the addresses clearly. 
 

 

Addresses do not export well to the generic format. You will probably get a 
better result if you export to the Excel Format and then try to import the 
results from the excel file into your spreadsheet program. 
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Using Pattern Matching In Your Searches 
You use wildcard characters as placeholders for other characters when you are specifying 
a value you want to find and you:  
¾ Know only part of the value. 
¾ Want to find values that start with a specific letter or match a certain pattern.  

In the Search and Advanced Search utility you can use the following characters to find 
such field value. 

Character Usage Example 
* Matches any number of characters. 

It can be used as the first or last 
character in the character string. 

wh* finds what, white, and 
why 

? Matches any single alphabetic 
character. 

B?ll finds ball, bell, and bill 

[ ] Matches any single character within 
the brackets. 

B[ae]ll finds ball and bell but 
not bill 

! Matches any character not in the 
brackets. 

b[!ae]ll finds bill and bull but 
not bell 

- Matches any one of a range of 
characters. You must specify the 
range in ascending order (A to Z, not 
Z to A). 

b[a-c]d finds bad, bbd, and bcd

# Matches any single numeric 
character. 

1#3 finds 103, 113, 123 

 
Notes    
¾ Wildcard characters are meant to be used with text data types, although you can 

sometimes use them successfully with other data types, such as dates, if you don't 
change the Regional Settings properties for these data types. 

 

¾ When using wildcard characters to search for an asterisk (*), question mark (?), 
number sign (#), opening bracket ([), or hyphen (-), you must enclose the item 
you're searching for in brackets. For example, to search for a question mark, type 
[?]. If you're searching for a hyphen and other characters simultaneously, place 
the hyphen before or after all the other characters inside the brackets. (However, 
if you have an exclamation point (!) after the opening bracket, place the hyphen 
after the exclamation point.) If you're searching for an exclamation point (!) or 
closing bracket (]), you don't need to enclose it in brackets. 

¾ You can't search for the opening and closing brackets ([ ]) together because the 
Microsoft® Jet query system interprets this combination as a zero-length string. 
You must enclose the opening and closing brackets in brackets ([[ ]]). 





 

Chapter 6: Mail Merge 
 
The Mail Merge facility allows you to write a standard letter from which the system can 
then generate personalised letters using a query that you specify. When you start Mail 
Merge, you will be prompted for a Query Source File. This is the file that the system 
uses to obtain the personalised details.  
 
Before supplying a query file, it is often prudent for you to open it using the Advanced 
Search utility so that you can be assured that it returns the records that you want. Once 
you have specified the source query file, you will be presented with the following 
window. 

 
 
The above window is a typical document editor with added features for mail merge 
processing. You will find that you will be able to perform most of the functions you will 
need by selecting the toolbar buttons. To find out what a particular toolbar button does, 
place the mouse pointer over it for about 3 seconds and you will get a tool tip. 
 

Text Editing Functions 
After you have specified the source SQL file, you must then supply a document giving 
the standard letter. To do this, you can either type a new letter or open an existing one 
which you can modify, if you wish, before you run the mail merge. The editor supports 
several file handling and document formatting functions. To get a feel of what a standard 
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letter looks like, have a look at the sample provided in your Letters folder that is also 
reproduced below. 

 
 

Creating A New Document 
When you start the Mail Merge utility, it automatically loads a new document for you. If 
during your mail merge job you decide to create another document that will use the same 
SQL file, choose the ‘New’ icon in the document toolbar.  
 
To create a new document that will use a different SQL source file, use the Start New 
Session option outlined below instead. 

Opening A File 
1. Click the Open icon in the toolbar.  
2. Locate the file in the window provided and double click it. If you come across 

anything in this window that you do not understand, you can get additional help by 
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clicking the What’s This icon shown in the diagram below and then clicking the item 
you want to find more information about. 

 
 

Saving A File 
1. Click the Save icon.  
2. If the file does not have a filename, you will be prompted to specify a filename. If 

you need more information on any of the items in the windows that will be displayed, 
click the “What’s This” help button and then click the item you want additional 
information on. 

 

Saving A File Under A Different Filename 
If you wish to save the changes you will have made to the existing file but still want to 
keep the old version, you must save the displayed file under a different filename. To do 
this, 
1. From the File menu, choose “Save As”. 
2. You will be prompted to specify a filename. If you need more information on any of 

the items in the windows that will be displayed, click the “What’s This” help button 
and then click the item you want additional information on. 

Printing the Standard Letter 
1. Click the Print icon.  
2. A standard Print window from which you should choose the Print button will then 

prompt you. If you need more information on any of the items in the windows that 
will be displayed, click the “What’s This” help button and then click the item you 
want additional information on. 

Searching For Words or Phrases 
There will be times when you will want to locate a particular word or phrase from your 
standard letter. Steps for doing this are outlined below. 
1. Choose the New Search icon  
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2. You will be resented with the following window. 

 
3. In the Find What box, enter the text you want to locate. 
4. Select the Whole Word option if you would like to find whole word only. 
5. Select the Match Case option if you would like the matches to be only returned if 

they match the word you specified in terms of capitalisation. 
6. Select Find Next to locate the first match. 
7. To find additional matches either 

a. Choose the Find Next button. 
Or 

b. Close the Find window by selecting Cancel and then press the click the Find 
Next icon  

 
To start a new search, repeat the above steps. If the Find window is already open, simply 
type in the new word you want to look up and then choose the Find Next button. 
 

Replacing Words or Phrases 
1. Select Search and Replace from the Edit menu. 
2. You will be presented with the following window. 

 
3. In the Find What box, enter the text you want to replace. 
4. In the Replace With box, enter the text you would like to replace the text you will 

have specified above. 
5. Select the Whole Word option if you would like to find whole word only. 
6. Select the Match Case option if you would like the matches to be only returned if 

they match the word you specified in terms of capitalisation. 
7. If you want to replace all the occurrences in just “one go” then select the Replace All 

button. To replace items one by one, 
a. Click the Replace button. If a match is currently selected, the system will 

replace that single occurrence. If there is no match selected, the system will 

 40



 

 41

find the next match, select it and replace it the next time you click the Replace 
button 

b. If you come across an occurrence that you would like to skip over without 
replacing, select Find Next when it is selected. 

c. You can stop replacements at any time by choosing the cancel button. 

Spell Checking Your Document 
1. Select Spell Check from the Edit menu or select the Spell Check icon from the 

toolbar. 

 
2. If a spelling error is discovered you have three options 

a. Replace the word with one of the suggestions. 
i. Select the suggestion from the list  

ii. Choose Change 
b. Replace the word with a word that you type in yourself. 

i. Type in the replacement word in the Replace With box 
ii. Choose Change 

c. Ignore the spelling error by choosing Ignore 

Cutting, Copying and Pasting 
The Levy system provided standard cut, copy and paste functions for text.  
¾ To copy some text, select the text and then select the copy icon from the toolbar 

. The keyboard shortcut is Ctrl⊕ C. 
¾ To cut some text, select the text and then select the cut icon from the toolbar . 

The keyboard shortcut is Ctrl⊕ X. 
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¾ To paste some text, place the cursor where you want the text to be inserted and 
then select the paste icon from the toolbar.  The keyboard shortcut is Ctrl⊕V. 

These functions may work with pictures but this is not guaranteed. To get reliable results 
with pictures, use the keyboard shortcuts instead. 
 

Dealing with Fonts 
The document formatting used in the mail merge facility supports several fonts, font sizes 
and text effects like colour and underlining. To use these formatting facilities, 
1. Select the Fonts icon.  
2. You will be presented with the following window. 

 
3. Select the options you want. Note that the window your operating system presents to 

you may look a bit different. 
4. Choose OK. 
 
Alternatively, you can use the toolbar formatting functions. To find out what each does, 
place your mouse over its icon for about 3 seconds. 
 

Changing Case 
You can change any selection of text to all capitals or small letters. To convert a selection 
into all capitals, select the capitalise  icon. For the reverse, use the “To Lower Case”  
option. 

Inserting a Date Into Your Document 
1. Place the cursor where you want the date to be inserted. 
2. Select the Insert Date icon.  
3. You will be presented with following window. Double click the date you wish to 

include. To insert a date not displayed in the calendar, use the buttons in the top left 
and right corners to browse to the calendar for the year you want. 



 

 

 

 

Inserting A Picture Into Your Document 
1. Place the cursor where you would like the picture to be inserted. 
2. Select Picture from the Insert menu. 
3. Select the picture file you would like to insert from the list of files provided. 
 

Inserting Another Document File Into Your Current Document 
1. Place the cursor where you would like the picture to be inserted. 
2. Select File from the Insert menu. 
3. Select the file you would like to insert from the list of files provided. 
 

Mail Merge Functions 

Merge Fields 
A merge field is a label instructing the system to insert a personalised detail at the 
position in the document at which the merge field is. For example, in the sample letter 
show at the beginning of this chapter there is a merge field for the address represented by 
«Guardian Address». This label is in fact an instruction to the system to replace 
«Guardian Address» with the contents of the “Guardian Address” column in the result of 
the query specified in the source SQL file that you supply when you are starting a merge 
session. To insert a merge field, 
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1. Place the cursor where you would like the personalized detail to be inserted 
2. Do one of the following 

a. Click the insert merge field icon  and select the field you want from the 
list that will be provided from a window looking like the one shown 
below. You select by either double clicking the field in the list or clicking 
the field and then the OK button. 

 
 

b. Press the right button of your mouse. You will be presented with a pop up 
menu from which you can then select the field you want 

 
c. Select Insert Field from the Mail Merge menu and follow the steps 

outlined under the first option. 
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Previewing The Personalised Letters 
Before printing the personalised letters, you may want to have a look at how they will 
appear. To do this, choose the Preview Mail Merge  icon from the toolbar. This will 
display a window with a list of all the letters with the personalised details inserted. A 
sample of the window is shown below 
 

 
 

Producing Personalised Letters 
To produce your personalised letters, simply choose the Produce Personalised Letters 

 icon. You will be shown a progress bar as the letters are produced. If the source query 
is complex, the system might take a little while before displaying the progress bar. Please 
be patient. 
 

Viewing The Query Source 
If for some reason you want to see what the source query you just specified contain, 
choose View Query Source from the Mail Merge option. This maybe particularly useful 
when the system presents you with a list of field names that you did not expect. 
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Starting A New Session 
A mail merge session is based on a single SQL file. If at any point you decide that you 
want to use a different SQL file, you must start a new Session. To do this, choose “New 
Session” from the Mail Merge menu. 
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Appendix: GNU GENERAL PUBLIC LICENSE  
Version Information 
 
� Version 2, June 1991 
� Copyright (C) 1989, 1991 Free Software Foundation, Inc. 59 Temple Place, Suite 

330, Boston, MA  02111-1307 USA 
� Everyone is permitted to copy and distribute verbatim copies of this license 

document, but changing it is not allowed. 

Preamble 
The licenses for most software are designed to take away your freedom to share and 
change it.  By contrast, the GNU General Public License is intended to guarantee your 
freedom to share and change free software--to make sure the software is free for all its 
users.  This General Public License applies to most of the Free Software Foundation's 
software and to any other program whose authors commit to using it.  (Some other Free 
Software Foundation software is covered by the GNU Library General Public License 
instead.)  You can apply it to your programs, too. 
 
When we speak of free software, we are referring to freedom, not price.  Our General 
Public Licenses are designed to make sure that you have the freedom to distribute copies 
of free software (and charge for this service if you wish), that you receive source code or 
can get it if you want it, that you can change the software or use pieces of it in new free 
programs; and that you know you can do these things. 
 
To protect your rights, we need to make restrictions that forbid anyone to deny you these 
rights or to ask you to surrender the rights. These restrictions translate to certain 
responsibilities for you if you distribute copies of the software, or if you modify it. 
 
For example, if you distribute copies of such a program, whether gratis or for a fee, you 
must give the recipients all the rights that you have.  You must make sure that they, too, 
receive or can get the source code.  And you must show them these terms so they know 
their rights. 
 
We protect your rights with two steps: (1) copyright the software, and (2) offer you this 
license which gives you legal permission to copy, distribute and/or modify the software. 
 
Also, for each author's protection and ours, we want to make certain that everyone 
understands that there is no warranty for this free software.  If the software is modified by 
someone else and passed on, we want its recipients to know that what they have is not the 
original, so that any problems introduced by others will not reflect on the original authors' 
reputations. 
 



 

Finally, any free program is threatened constantly by software patents.  We wish to avoid 
the danger that redistributors of a free program will individually obtain patent licenses, in 
effect making the program proprietary.  To prevent this, we have made it clear that any 
patent must be licensed for everyone's free use or not licensed at all. The precise terms 
and conditions for copying, distribution and modification follow. 

TERMS AND CONDITIONS 
0. This License applies to any program or other work which contains a notice placed by 
the copyright holder saying it may be distributed under the terms of this General Public 
License.  The "Program", below, refers to any such program or work, and a "work based 
on the Program" means either the Program or any derivative work under copyright law: 
that is to say, a work containing the Program or a portion of it, either verbatim or with 
modifications and/or translated into another language.  (Hereinafter, translation is 
included without limitation in the term "modification".)  Each licensee is addressed as 
"you". 
 
Activities other than copying, distribution and modification are not covered by this 
License; they are outside its scope.  The act of running the Program is not restricted, and 
the output from the Program is covered only if its contents constitute a work based on the 
Program (independent of having been made by running the Program). Whether that is 
true depends on what the Program does. 
 
  1. You may copy and distribute verbatim copies of the Program's source code as you 
receive it, in any medium, provided that you conspicuously and appropriately publish on 
each copy an appropriate copyright notice and disclaimer of warranty; keep intact all the 
notices that refer to this License and to the absence of any warranty; and give any other 
recipients of the Program a copy of this License along with the Program. 
 
You may charge a fee for the physical act of transferring a copy, and you may at your 
option offer warranty protection in exchange for a fee. 
 
  2. You may modify your copy or copies of the Program or any portion of it, thus 
forming a work based on the Program, and copy and distribute such modifications or 
work under the terms of Section 1 above, provided that you also meet all of these 
conditions: 
 
    a) You must cause the modified files to carry prominent notices stating that you 
changed the files and the date of any change. 
 
    b) You must cause any work that you distribute or publish, that in whole or in part 
contains or is derived from the Program or any part thereof, to be licensed as a whole at 
no charge to all third parties under the terms of this License. 
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 c) If the modified program normally reads commands interactively when run, you must 
cause it, when started running for such interactive use in the most ordinary way, to print 
or display an announcement including an appropriate copyright notice and a notice that 
there is no warranty (or else, saying that you provide a warranty) and that users may 
redistribute the program under these conditions, and telling the user how to view a copy 
of this License.  (Exception: if the Program itself is interactive but does not normally 
print such an announcement, your work based on the Program is not required to print an 
announcement.) 
 
These requirements apply to the modified work as a whole.  If identifiable sections of that 
work are not derived from the Program, and can be reasonably considered independent 
and separate works in themselves, then this License, and its terms, do not apply to those 
sections when you distribute them as separate works.  But when you distribute the same 
sections as part of a whole which is a work based on the Program, the distribution of the 
whole must be on the terms of this License, whose permissions for other licensees extend 
to the entire whole, and thus to each and every part regardless of who wrote it. 
 
Thus, it is not the intent of this section to claim rights or contest your rights to work 
written entirely by you; rather, the intent is to exercise the right to control the distribution 
of derivative or collective works based on the Program. 
 
In addition, mere aggregation of another work not based on the Program with the 
Program (or with a work based on the Program) on a volume of a storage or distribution 
medium does not bring the other work under the scope of this License. 
 
  3. You may copy and distribute the Program (or a work based on it, under Section 2) in 
object code or executable form under the terms of Sections 1 and 2 above provided that 
you also do one of the following: 
 
    a) Accompany it with the complete corresponding machine-readable source code, 
which must be distributed under the terms of Sections 1 and 2 above on a medium 
customarily used for software interchange; or, 
 
    b) Accompany it with a written offer, valid for at least three years, to give any third 
party, for a charge no more than your cost of physically performing source distribution, a 
complete machine-readable copy of the corresponding source code, to be distributed 
under the terms of Sections 1 and 2 above on a medium customarily used for software 
interchange; or, 
 
    c) Accompany it with the information you received as to the offer to distribute 
corresponding source code.  (This alternative is allowed only for non-commercial 
distribution and only if you received the program in object code or executable form with 
such  an offer, in accord with Subsection b above.) 
 
The source code for a work means the preferred form of the work for making 
modifications to it.  For an executable work, complete source code means all the source 
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code for all modules it contains, plus any associated interface definition files, plus the 
scripts used to control compilation and installation of the executable.  However, as a 
special exception, the source code distributed need not include anything that is normally 
distributed (in either source or binary form) with the major components (compiler, kernel, 
and so on) of the operating system on which the executable runs, unless that component 
itself accompanies the executable. 
 
If distribution of executable or object code is made by offering access to copy from a 
designated place, then offering equivalent access to copy the source code from the same 
place counts as distribution of the source code, even though third parties are not 
compelled to copy the source along with the object code. 
 
  4. You may not copy, modify, sublicense, or distribute the Program except as expressly 
provided under this License.  Any attempt otherwise to copy, modify, sublicense or 
distribute the Program is void, and will automatically terminate your rights under this 
License. However, parties who have received copies, or rights, from you under this 
License will not have their licenses terminated so long as such parties remain in full 
compliance. 
 
  5. You are not required to accept this License, since you have not signed it.  However, 
nothing else grants you permission to modify or distribute the Program or its derivative 
works.  These actions are prohibited by law if you do not accept this License.  Therefore, 
by modifying or distributing the Program (or any work based on the Program), you 
indicate your acceptance of this License to do so, and all its terms and conditions for 
copying, distributing or modifying the Program or works based on it. 
 
  6. Each time you redistribute the Program (or any work based on the Program), the 
recipient automatically receives a license from the original licensor to copy, distribute or 
modify the Program subject to these terms and conditions.  You may not impose any 
further restrictions on the recipients' exercise of the rights granted herein.You are not 
responsible for enforcing compliance by third parties to this License. 
 
  7. If, as a consequence of a court judgment or allegation of patent infringement or for 
any other reason (not limited to patent issues), conditions are imposed on you (whether 
by court order, agreement or otherwise) that contradict the conditions of this License, 
they do not excuse you from the conditions of this License.  If you cannot distribute so as 
to satisfy simultaneously your obligations under this License and any other pertinent 
obligations, then as a consequence you may not distribute the Program at all.  For 
example, if a patent license would not permit royalty-free redistribution of the Program 
by all those who receive copies directly or indirectly through you, then the only way you 
could satisfy both it and this License would be to refrain entirely from distribution of the 
Program. 
 
If any portion of this section is held invalid or unenforceable under any particular 
circumstance, the balance of the section is intended to apply and the section as a whole is 
intended to apply in other circumstances. 
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It is not the purpose of this section to induce you to infringe any patents or other property 
right claims or to contest validity of any such claims; this section has the sole purpose of 
protecting the integrity of the free software distribution system, which is implemented by 
public license practices.  Many people have made generous contributions to the wide 
range of software distributed through that system in reliance on consistent application of 
that system; it is up to the author/donor to decide if he or she is willing to distribute 
software through any other system and a licensee cannot impose that choice. 
 
This section is intended to make thoroughly clear what is believed to be a consequence of 
the rest of this License. 
 
  8. If the distribution and/or use of the Program is restricted in certain countries either by 
patents or by copyrighted interfaces, the original copyright holder who places the 
Program under this License may add an explicit geographical distribution limitation 
excluding those countries, so that distribution is permitted only in or among countries not 
thus excluded.  In such case, this License incorporates the limitation as if written in the 
body of this License. 
 
  9. The Free Software Foundation may publish revised and/or new versions of the 
General Public License from time to time.  Such new versions will be similar in spirit to 
the present version, but may differ in detail to address new problems or concerns. 
 
Each version is given a distinguishing version number.  If the Program specifies a version 
number of this License which applies to it and "any later version", you have the option of 
following the terms and conditions either of that version or of any later version published 
by the Free Software Foundation.  If the Program does not specify a version number of 
this License, you may choose any version ever published by the Free Software 
Foundation. 
 
  10. If you wish to incorporate parts of the Program into other free programs whose 
distribution conditions are different, write to the author to ask for permission.  For 
software which is copyrighted by the Free Software Foundation, write to the Free 
Software Foundation; we sometimes make exceptions for this.  Our decision will be 
guided by the two goals of preserving the free status of all derivatives of our free 
software and of promoting the sharing and reuse of software generally. 
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No Warranty 
 
  11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE; THERE IS NO 
WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY 
APPLICABLE LAW.  EXCEPT WHEN OTHERWISE STATED IN WRITING THE 
COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM 
"AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR 
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.  THE 
ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM 
IS WITH YOU.  SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME 
THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. 
 
  12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO 
IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO 
MAY MODIFY AND/OR REDISTRIBUTE THE PROGRAM AS PERMITTED 
ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, 
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF 
THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT 
LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR 
LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE 
PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH 
HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES. 
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